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What’s New in Chief
Architect X4

Welcome to Chief Architect X4. This guide has been 
written to help our upgrading customers make a 
smooth transition from earlier versions of Chief 
Architect to Chief Architect X4. 

Contents
•      Before You Begin
•      New and Improved Features

Before You Begin
There are many new features in Chief Architect X4, and many existing features have changed. These changes 
affect the way Chief Architect functions, so it is very important to be familiar with them. 

• “Getting Started Check List” on page 1

• “For Files Created in Version X3 and Prior” on page 3

• “For Files Created in Version X2 and Prior” on page 4

• “For Files Created in Version 10 and Prior” on page 5

Chief Architect X4 can open the .PL1, .LA1, .plan, and .layout files from prior versions. Before opening any 
files created in earlier versions of Chief Architect, it is important to be aware of changes made in the newest 
version and the effect they may have on your legacy plan and layout files. For details, see “For Files Created in 
Version X3 and Prior” on page 3, “For Files Created in Version X2 and Prior” on page 4 and “For Files Created 
in Version 10 and Prior” on page 5. 

As with any software, it is always best to finish any current projects you may have in progress in the version of 
the software in which you began them. If you do decide to bring a project forward, be sure to take the time to 
verify that everything in your drawing is correct when it is opened the new program version.

Getting Started Check List
The following checklist suggests steps you should take before migrating your files to Chief Architect X4. More 
information about each of these steps can be found after the checklist.

1.      Check for and Install Program Updates
2.      Migrate Legacy Library Files
3.      Migrate Custom Graphics Files
4.      Review the New Features List
5.      Review Your Preferences Settings
6.      Create new custom Template Plan and Layout files
7.      Set up Custom Toolbar Configurations
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8.      Export Entire Plan
9.      Check www.chiefarchitect.com for more information

1. Check for and Install Program Updates
Program updates contain improvements to the original release version and we recommend using the most 
current version available. By default, Chief Architect checks for program updates every day when you launch 
the program. Please note that program updates are available for download, which means that you need internet 
access to acquire them.

You can check for updates at any time: 

• Select Help> Download Program Updates from the menu. 

• Visit the Program Updates page on the Chief Architect Web site at www.chiefarchitect.com. 

2. Migrate Legacy Library Files 
Extensive changes were made in Chief Architect X4 to the structure and functionality of the library. Library 
content from previous program versions cannot be installed or copied into the Chief Architect X4 library. 

If you have Chief Architect X3 installed on your computer, the Chief Architect X4 installer will locate your 
Chief Architect X3 User Libraries and will ask if you want to import them for use in Chief Architect X4. You 
can also import library files from version X3 at any time by selecting Library> Import Library (.calib, 
.calibz) from the program menu.

If you have custom library content from Chief Architect X2 or prior, the installer will not find your custom 
library content. If you would like to bring your custom library content forward into Chief Architect X4, you 
can do so by selecting Library> Convert Legacy (.alb) Library Files from the program menu.

3. Migrate Custom Graphics Files
If you have custom graphics files, including textures, images or backdrops, that you were using in a previous 
program version, you can copy them manually using Windows Explorer for use in Chief Architect X4. 

• Copy custom texture files to the Chief Architect X4 Textures folder located in the Chief Architect X4 Data 
folder. 

• Copy custom image files to your Chief Architect X4 Images folder located in the Chief Architect X4 Data 
folder. 

• Copy custom backdrop files to your Chief Architect X4 Backdrops folder located in the Chief Architect X4 
Data folder. 

In Chief Architect X3, X2 and X1, custom graphics were saved in the Chief Architect Data folder, as they are 
in version X4. In version 10 and prior, they were located in the program’s installation directory, in folders that 
began with “My”. Custom backdrops, for example, were saved in “My Backdrops”. 

Texture and image files are not listed in the Library Browser. These files can be assigned to material and image 
objects, however, which are stored in the library so it is important to retain them.

4. Review the New Features List 
There are a number of important reasons why you should familiarize yourself with the new and improved 
features in Chief Architect X4:

• New and improved features allow you to produce drawings more efficiently, so it is to your advantage to 
use them. 

• Some changes to existing functionality may affect your accustomed drawing style and thus your productiv-
ity if you are not aware of them. 

• New features may affect your choice of settings in your template files, as well as your preferred Preferences 
settings. 

See “New and Improved Features” on page 5. 

http://www.chiefarchitect.com/
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5. Review Your Preferences Settings 
Any changes that you made to the Preferences settings in your previous version do not migrate into Chief 
Architect X4. You should review all the settings in the Preferences dialog to make sure that they are set to suit 
your drawing needs.

6. Create new custom Template Plan and Layout files 
Chief Architect X4 installs a selection of template plan and layout files that have been set up to take advantage 
of the program’s updated tools and features. For best results, it is recommended that you either: 

• Use the installed templates when creating new plans and layout files in Chief Architect X4

• Use the installed templates as the basis for creating new custom templates.

If you choose to continue using custom template files that you created in a previous program version, it is very 
important that you take the time to carefully review all the default settings in the file, making sure that they will 
continue to suit your needs in X4. First, make copies of your custom templates in the Chief Architect X4 The 
Templates directory is located in the Chief Architect X4 Data folder in Windows Explorer. Next, open each 
template as you would a regular plan or layout file, by selecting File> Open, and then save any changes you 
make by selecting File> Save.

If you do choose to continue using a legacy template plan, it is best to also use a legacy layout template from 
the same program version, as well. As with a template plan, take the time to go through the layout template’s 
defaults and make sure they are suited for use in X4 and that their line weight scales do not conflict with those 
in your template plans.

7. Set up Custom Toolbar Configurations 
It is possible to migrate toolbar configuration files from previous versions to Chief Architect X4; however, it is 
not recommended because it is likely that you will be missing new tools available in version X4. 

Instead, we recommend that you set up your custom toolbars the way you would like them in Chief Architect 
X4. You may find it most effective to customize your toolbars as you get used to working in the new program 
version, rather than beforehand.  

8. Export Entire Plan
Before migrating a legacy file created in Chief Architect X3 or prior, it is a good idea to open the plan in the 
program version in which is was created and use the Export Entire Plan tool (renamed Backup Entire Plan in 
version X3) to export the plan with all associated support files, including textures, backdrops and images.  

9. Check www.chiefarchitect.com  for more information
If you have additional questions about the changes in Chief Architect, up to date information is available in the 
Support section of our web site. You can also post questions on the Chief Talk web forum at 
www.chieftalk.com.

For Files Created in Version X3 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version X3 or 
prior, bear in mind the following before you open legacy files in Chief Architect X4.

1. Text Styles
The appearance of a number of objects that include text - including the North Pointer, Sun Angles, Joist 
Direction Lines, the Up/Down arrows for stairs and ramps - can now be controlled using Text Style. Their 
appearance may be altered somewhat in legacy plans opened in Chief Architect X4. See 

2. Light Sources
The illumination created by light fixtures and Added Lights was improved in Chief Architect X4. Lighting in 
legacy plans may appear noticeably brighter when viewed in version X4. See 

http://www.chieftalk.com/
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For Files Created in Version X2 and Prior
If you wish to open files created in Chief Architect Version X2 or prior, bear in mind the following file 
management changes and structural enhancements before you open legacy files in Chief Architect X4.

1. Material textures, images, and backdrops
Chief Architect X2 and prior installed with a catalog of library content, including a selection of material 
textures, images, and backdrops. This library catalog is no longer installed with the program because it is now 
available for download on-demand, so it will be possible to open a legacy plan in version X4 and encounter 
numerous missing file warnings. To avoid this, we recommend using the Export Entire Plan feature in the 
original program version to create a folder that includes the plan and all associated textures, images, and 
backdrops before opening this file in X4. This tool is renamed Backup Entire Plan in version X4.

2. Floor and ceiling finish thicknesses
In Chief Architect X2 and prior, floor and ceiling finish layers were not modeled in 3D, and objects such as 
railings, stairs, landings, cabinets, fixtures, and furnishings measured their Floor to Bottom height from the 
subfloor. These objects now measure their Floor to Bottom height from the floor finish surface by default, so it 
is possible that you may notice height changes for these objects - particularly in saved, annotated cross section/
elevation views.

3. Riser heights and landing thicknesses
The default Best Fit Riser Height for stairs that do not reach the next level has been updated from 9” (225 mm) 
in version X2 and prior to 6 3/4” (169 mm) in Chief Architect X4.

4. Auto Adjust Height
The Follow Terrain option in some specification dialogs was replaced by the Auto Adjust Height checkbox. If 
a cabinet, fireplace, fixture, furniture, or other library symbol had Follow Terrain unchecked in version X2 or 
prior and was located in a room with a floor height other than the default for the current floor, then the object’s 
Floor to Bottom Height will change to equal that room’s floor height. The object’s position in the model will 
not change, however. 

5. Adjustable Thickness Walls
In Chief Architect X2 and prior, generic, single-layer wall types were available for use. When a legacy plan file 
is opened in version X4 and these wall types are detected, they are replaced by an updated, non-generic wall 
type. Framed walls and Railings will also acquire 1/2” (13 mm) thick layers of sheetrock on each side.

6. Stairwells defined by railings
Interior railings that used a generic, single-layer wall type drawn in older program versions will acquire layers 
of sheetrock when the plan is opened in version X4. This can affect the appearance of staircases where they 
join to a floor platform. To address this issue, select the railing and move it 1/2” (13 mm) away from the top 
edge of the staircase. 

7. Deck rooms
In legacy plans opened in Chief Architect X4, Deck rooms with Advanced Deck Framing built retain the 
framing but have Automatic Deck Framing turned off by default. Decks with no Advanced Deck Framing built 
are converted to Balcony rooms.

8. Material definitions and light sources
Settings in the Define Material dialog that affect materials’ appearance of brightness have been modified. The 
Ambient setting was removed, and the Diffuse setting for materials in legacy plans will be set to 100% when 
opened in version X4. 

The Quality setting for light sources set to use Soft Shadows in ray tracing was also modified. Lights using Soft 
Shadows in legacy plans will be set to use Medium quality. The Light Diameter of light sources in legacy plans 
is capped at 4” (100 mm).
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9. Structural Member Reporting
When a plan created in Chief Architect X2 or prior is opened in Chief Architect X4, Materials Lists are set to 
calculate Total Lineal Length. For a combination of lineal length and piece count, select Mixed Reporting in 
the Structural Member Reporting dialog. See

10. Fill New Framing Members
In Chief Architect X2 and prior, Fill New Framing Members was view-specific; in Chief Architect X4 it 
applies to the entire plan. As a result, it is turned off by default in legacy plans opened in version X4.

For Files Created in Version 10 and Prior
In addition to the above recommendations, if you wish to open files created in Chief Architect Version 10 or 
prior, these additional steps are also suggested before you open legacy files in Chief Architect X4.

1. Select the desired Layer Set 
Before migrating a legacy file created in Chief Architect Version 10, open it in Version 10 and make sure that 
the active layer set is one that is useful in most situations. Extensive changes to layer sets since Version 10 
allow only the active layer set to be migrated in Chief Architect X4.

2. Set up your Legacy File Conversion Preferences 
Several different preference settings allow you to control how legacy files from Version 9.5 and prior are 
migrated into Chief Architect X4. You may want to do some experiments with these settings so that you fully 
understand how they affect your older plans when they are read into Chief Architect X4:

 a. Set your legacy text and dimension conversion fonts - Set your Legacy Text Conversion and Leg-
acy Dimension Conversion fonts in the Preferences dialog before opening any old plans. Use the 
same settings here that you had in your preferences for your previous version of Chief Architect so 
that your text and dimensions will look the same.

 b. Set your legacy plan and layout page setup information - Page Setup information can be done on 
an individual plan basis. Use the Page Setup preference for legacy plans and layouts so that your plans 
and layouts are set up the same way they were in your previous version. Note: You should make sure 
you leave the scale for layouts at 1 to 1.

 c. Set your legacy layer conversion settings - Significant changes have been made to improve the setup 
and control of layers. Preference settings have been provided to control how your legacy plan layers 
are converted when you open a previous version plan in Version X4. By default, layers should be con-
verted into the new format so that they more closely match the defaults that we provide in the template 
plans. You can modify these settings so that your layers more closely match how they looked in your 
previous version.

3. Replace problem symbols
In recent versions of Chief Architect, any symbols placed in a plan are saved with the plan file and can be read 
by Chief Architect X4. If you open a plan file created in an older version of Chief Architect and notice 
problems with a symbol, however, you can either delete it or replace it with a new symbol from Chief Architect 
X4 library.

New and Improved Features
The following is a list of  new and improved features 
in Chief Architect Version X4.

Installation
• Chief Architect Premier X4 is now available in 

both 32-bit and 64-bit versions.

• Sample plans are no longer installed with the pro-
gram and are now available online. 

Program Overview
• Can now highlight the Product Key in the About 

Chief Architect dialog.
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• The Chief Architect Viewer can now read files 
from both Chief Architect Premier and Chief 
Architect Interiors.

File Management
• Search for Plans  command moved from File 

menu to Tools> Plan Database submenu.
• New Scripts folder in Chief Architect X4 Data 

folder for custom user-created Ruby scripts.

Preferences & Default Settings
• New Set As Default  edit tool allows you to spec-

ify the attributes of a selected object as the 
defaults for objects of that type. 

• New Text Styles allow you to apply the same 
default text settings to all object using dynamic 
defaults for text information. 

• Can now specify whether Leader Lines  cre-

ate Text  or Rich Text .

• Can now specify whether Alternate  drawing 
behavior restarts after a closed shape is created.

• Can now specify values in 1/10ths of a foot in the 
General Plan Defaults dialog.

• Obsolete Enhanced Line Drawing and Lower 
Interactive Quality settings in the Preferences 
dialog have been removed. 

• Can now specify whether the Alternate continu-
ous drawing behavior remains active when a 
closed shape is drawn in the Preferences dialog. 

• Can now specify a Codec for walkthrough 
recordings in the Preferences dialog. 

Layers

• New Object Layer Properties  edit tool lets 
you access and modify the layer settings associ-
ated with a selected object. 

• New Layer Hider  tool lets you turn off all 
objects on a layer by simply clicking on one of 
those objects. 

• New Text Style attribute for layers.
• New Full Camera, Floor Camera, Full Overview, 

Floor Overview, Clipped Section and Wall Eleva-
tion layer set options in Layer Set Defaults dia-
log. 

Walls, Railings & Fencing
• Improved wall drawing: program will automati-

cally orient exterior walls to face outward regard-
less of which direction they are drawn. 

• Can now resize walls using dimensions in addi-
tion to moving them. 

• Can now locate foundation wall footings using 
dimensions. 

• Reorganized Wall Specification dialog with new 
Structure tab for greater ease of use.  

• New Wall Intersection settings let you control 
which walls build through at  intersections.

• Can now display lines to distinguish which walls 
build through at intersections.  

• Can now specify the Height of Lower Pony 
Wall in the Wall Specification dialog.

• New Slab Footing  wall tool creates interior foot-
ings and defines rooms with Monolithic Slab 
foundations.

• Slab Footing Defaults dialog lets you control 
default footing size and other attributes of Mono-
lithic Slab foundations. 

• New Bearing Wall specification produce a foun-
dation wall below the selected wall.

• Improved how the Align With Wall Above  

and Align With Wall Below  edit tools work 
with Pony Walls.

• Can now specify the Pour Number of concrete 
Foundation and Footing Walls.

• Can now specify a chamfer for slab footings.
• Can now specify the handrail for Framed Panel 

Railings. 
• Double Wall checkbox removed from Wall 

Specification dialog. Walls are specified as 
Frame Through by default.

• Wall layers no longer extend down to cover the 
sides of slab foundations. 

• New Brick Ledge Depth setting lets you control 
the brick ledge size for brick walls built on in 
monolithic slab foundations.

• New Foundation to This Line option and Offset 
setting let you control how foundation walls align 
with walls above.

• Obsolete 8” Concrete Stem Wall 4” Brick Ledge 
wall type removed from installed template plans.
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Rooms
• Can now control the Text Style of room labels.
• Can now specify the Pour Number of rooms on 

Floor 0 when a Monolithic Slab foundation has 
been built.

• The Room Area portion of room labels now use 
the same fill style as the Room Name portion.

• Interior “island” rooms defined by walls that do 
not connect to other walls in the plan are now 
automatically connected with an Invisible Wall to 
avoid undesirable program behavor.

Doors and Windows
• New Concrete Cutout specification lets you 

adjust the size of the cutout for doors and win-
dows placed in pony walls wsith concrete lower 
walls, and concrete garage curbs, independent of 
the rough opening.

• New, separate defaults dialogs for Pocket, Bifold 
and Garage Doors, Doorways, Interior and Exte-
rior Sliding Doors.

• New Show Door Open in 3D  and Show 

Door Closed in 3D  edit tools.
• Can now customize the labels of Bay, Box and 

Bow Windows.
• Can now specify label offsets for doors and win-

dows parallel to the object front, not just perpen-
dicular to it.

• New Louver Size setting in the Door and 
Window Specification dialogs.

• The Single Label option for mulled units was 
moved to the Label Tab of the Mulled Unit 
Specification dialog.

• Can now control the Text Style of door and win-
dow labels. 

• New Not Through option for doors and windows 
placed in Double Walls. 

Foundations
• New Slab Footing  wall tool and Slab Footing 

Defaults creates interior footings and defines 
rooms with Monolithic Slab Foundations.

• Monolithic Slab foundations are now modeled 
using walls with footings rather than Slab 
objects.

• Can now specify a chamfer for slab footings.

• Foundation wall footings can now be edited using 
edit handles in floor plan view.

• Can now specify how far Garage floor heights are 
lowered when a foundation is built.

• Can now specify curbs around Garage and Slab 
rooms when a Monolithic Slab foundation is 
built.

• Build Foundation  command is now available 
when a foundation has been built, making it eas-
ier to rebuild when needed.

• New Auto Rebuild Foundation option in the 
Build Foundation dialog replaces Rebuild Slabs 
command.

• Foundation step markers are now placed on their 
own layer.

• The locations of doors in the stem walls for 
Garage rooms on Floor 1are now shown on Floor 
0.

• Vertical Footing checkbox moved from the 
Build Foundation dialog to the Foundation Wall 
Defaults dialog. It is also available for individual 
foundation walls in the Foundation Wall 
Specification dialog.

• Can now control the Text Style of step markers 
on foundations.

Roofs
• New Roof labels display pitch and pitch direc-

tion.
• New Arrow tab lets you control arrow style of 

roof pitch indicators.

Stairs, Ramps & Landings
• Can now control display of Up/Down arrows on 

stairs and ramps by layer. 
• Can now control the arrow style and Text Style of 

the Up/Down arrows in stairs and ramps.

Framing
• Can now control the Text Style and arrow style of 

Joist Dimension Lines.

Trusses
• Can now turn off the generation of Lookouts, 

Eave Sub Fascia, Gable Fascia and Eave Fascia 
when roof framing is built.

• Can now control the Text Style of truss labels.



8

Chief Architect  X4 X4 Migration Guide

• Floor/ceiling and roof truss labels now obey the 
Minimum Display Size for labels. 

Electrical
• The Intensity setting for light sources has been 

replaced by settings measured in lumens that cor-
respond to light bulb wattages.

• New Turn Light(s) On and Off edit buttons for 
light fixtures and light sources make it easy to 
quickly turn selected lights on or off.

• Can now control the Text Style of electrical fix-
ture labels.

• Auto Place Outlets  now places GFCI outlets 
over cabinets in Kitchen rooms.Can now use the 
Alternate  continuous drawing mode with the 
Connect Electrical  tool.

Trim & Moldings
• New Horizontal Offset setting allows you to cre-

ate built up and/or recessed moldings in rooms 
and on cabinets and other objects.

• Improved ability to specify a vertical offset to 
moldings assigned to cabinet objects.

• Improved ability to place Corner Boards  and 
Quoins  at corners with curved walls.

Cabinets
• New Frameless cabinet option and Door/

Drawer Overlay settings in the Cabinet 
Specification dialogs. 

• Cabinet moldings are now calculated in the Mate-
rials List and are listed under “Interior Trim”.

• Can now specify labels for Soffits, Shelves and 
Partitions.

• Can now control the Text Style of cabinet labels.
• Single doors on pie-cut corner cabinets are no 

longer treated as doubled so hardware is not 
duplicated.

• Moldings applied to cabinets are now listed in the 
Materials List under the Interior Trim category

Terrain
• Terrain is now located 6” (187 mm) below the top 

of foundation stem walls rather than below the 
top of the treated sill plate.

• Font information for contour lines removed from 
the Terrain Specification dialog. Contour lines’ 
text is now set by Text Style.

• Can now turn off display of primary contour lines 
in Terrain Specification dialog.

• Can now turn off red highlight for negative eleva-
tion contour lines.

• Can now control the Text Style of Elevation 
Points.

• Can now control the Text Style of plant and 
sprinkler labels.

• Improved ability to select plants by clicking on a 
plant’s label.

Other Objects
• Can now specify labels for Soffits.

The Library
• Library content is no longer subscription-based.
• Publish Library Catalog feature removed from 

program. Libraries can still be exported.
• Library content is now saved in multiple .calib 

files rather than one database. Custom content 
can be backed up without backing up the whole 
library.

• New library shortcuts  let you copy items for 
organizational purposes without increasing 
library database size. 

• New Database Filtering lets you control display 
of items in library tree list.

• Improved speed of library content downloads and 
emptying of library Trash.

• Improved library download feedback lets you 
know when a download is complete or if there 
were download errors.

Materials
• New Reflective Material Class available in the 

Define Material dialog.

3D Views
• “Cameras, Inactive” layer renamed “Cameras” 

and controls appearance of both active and inac-
tive camera symbols in floor plan view.

• New “Cameras, Labels” layer lets you control 
display of camera labels independently of camera 
symbols in floor plan view.

• Camera labels how have their own edit handles 
and can be moved relative to the camera symbol 
in floor plan view.



New and Improved Features

 9

• New Always Display Active Cameras option in 
Camera Defaults dialog.

• Can now specify a selected saved or unsaved, 
active camera’s layer. See “Camera Specification 
Dialog” on page 796 and .

• Can now specify a selected cross section/eleva-
tion camera’s Rendering Technique in the 
Cross Section Camera Specification dialog.

• Reduced the minimum allowed Clip Surfaces 
Within value to 6” (150 mm).

• View Angle dialog removed from View Direc-
tion Tools.

• Overview Direction Tools  renamed View 
Direction Tools.

• Can no longer export images to the .pcx file type.

• Improved Auto Detail  tool displays insula-
tion behind wall top or bottom plates instead of in 
front of them.

Rendering & Ray Tracing
• Can now specify custom labels for Added Lights 

.
• New “Light Sources, Labels” layer lets you con-

trol the display of labels on Added Lights  in 
floor plan view.

• Can now control the Text Style and arrow style of 

Sun Angles .
• New Turn Light(s) On  and Off  edit buttons for 

light fixtures and light sources make it easy to 
quickly turn selected lights on or off.

• More information about light sources added to 
the Adjust Lights dialog.

• Sunlight can now shine through windows in ray 
trace views without using Caustic Photons.

• Improved quality of shadows associated with 
sunlight in ray trace views.

• Improved ray tracing speed by removing any 
lights in the model that do not contribute to direct 
lighting in the ray traced scene from the ray trace 
lighting calculations.

• Ambient Occlusion can now be used in interior 
ray trace views as well as exterior views.

• Improved ray trace time estimate and program 
feedback during ray trace pre-processing.

• Changed the color of Environment Lighting for 
exterior ray trace views in Sunny conditions from 
pale yellow to white.

• Gamma correction in ray trace views is now auto-
matic. Use Gamma Correction option removed 
from interface.

• Ray trace views can no longer be saved to the 
.pcx file type.

Dimensions

• New Add Additional Text  tool allows you to 
add text to dimension line labels.

• Can now control the Text Style - including the 
transparency and text color - of dimension labels.

• Font tab in Manual Dimension Defaults dialog 
replaced by Text Style tab. 

Text, Callouts & Markers
• New Text Styles allow you to apply the same 

default text settings to all objects using dynamic 
defaults for text information - including Text, 
Callouts and Markers, but not Rich Text.

• Can now specify whether Leader Lines  cre-

ate Text  or Rich Text  in the Preferences 
dialog.

• A number of new Object Specific text macros for 
doors, windows and stairs.

• Text macros for special characters no longer 
include % before and after the character.

CAD Objects
• Can now control the Text Style of CAD objects 

set to display line length or angle.
• Can now control the font of line styles that 

include text, as well as the text transparency.
• Can now control Text Style of North Pointers.
• Line Label Height setting removed from the CAD 

Defaults dialog as this setting is now controlled 
by Text Style.

• Increased accuracy of line Length as stated in the 
Line and Polyline Specification dialogs.

• CAD Block Management and CAD Detail 
Management dialogs are now resizable to better 
accomodate longer names.
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Project Management
• Can now control the Text Style of Room Box 

labels.

Pictures, Images, & Walk-
throughs

• Exported images can no longer be saved to .pcx 
file type.

Importing & Exporting
• Can now import and export AutoCAD 2012 com-

patible files.

Printing & Plotting
• Use Outline Printing option removed from Print 

dialog.

Layout
• Views sent to layout now have automatic labels 

stating basic information about the original view.
• Label tab added to the Layout Box Specification 

dialog.
• New Object Specific text macros for layout view 

box labels.

Schedules
• Can now control the Line Style, Fill Style and 

Text Style of schedules. 
• Can now include schedule number in the label of 

all objects with schedules except for rooms.
• Can now specify text Alignment in schedule col-

umns.
• Improved support of multiple schedules of the 

same type at the same time.
• Additional Text and Height/Width Display set-

tings now affect schedule columns as well as 
labels.

• New “Label” column for all schedules except 
Room Finish Schedules.

• New “Arch” column for Door and Window 
Schedules.

• New “Type” column for Window Schedules.

• New “Top” and “Bottom” columns for Door, 
Window and Cabinet Schedules.

• New “Floor Elevation” and “Floor Finish Eleva-
tion” columns for Room Finish Schedules.

• Character Height and Rotate with Plan settings 
for schedule callout labels removed from the 
Schedule Specification dialog. Schedule callout 
labels are now controlled using Text Styles.

• Improved the description of slab doors in Door 
Schedules. 

• When you choose to specify an object’s label, the 
text field is now initially populated by the 
selected object’s Automatic Label. 

• Removed Product Code Label checkbox from 
Schedule Specification dialog. 

Materials Lists
• New “Label” column in Materials Lists, the Mas-

ter List and the Components dialog lists object 
labels for reference purposes.

• Cabinet moldings are now calculated under the 
“Interior Trim” category. 

• Can now specify the Pour Number of concrete 
Foundation and Footing Walls and Monolithic 
Slab rooms. 

• New Size setting in the Preferences dialog lets 
you control the text size in Materials Lists, the 
Master List and the Components dialog.

Ruby Console
• New Automatic Label and Schedule Number 

Named Values.
• A number of new Named Values for doors, win-

dows, rooms, light fixtures, electrical outlets, 
stairs and layout boxes.

• The Ruby Console now remembers its position 
and previous activity when it is closed and later 
relaunched in the same program session.

Additional Resources
• Can now choose to View the NKBA Kitchen & 

Bathroom Guidelines from the program menu.
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